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DIARIO DI BORDO 
APPUNTI DA UN VIAGGIO



 
 
 
 

"Come la bianca ala dell'albatros 
sul monotono respiro del Pacifico 

così, vagabonda per vagare, 
va la vela del vero marinaio" 

 
- Hugo Pratt -
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CHI SONO/COSA FACCIO
Noi non ci conosciamo, perciò 
meglio conoscerci. 
Mi chiamo Andrea Bovaia, ho 
23 anni e vivo a Parma. Ho 
giocato a calcio dodici anni, ho 
una cicatrice sulla coscia destra e 
ho solo due denti del giudizio 
perché gli altri due me li hanno 
tolti. 

Mi sono diplomato geometra 
all'istituto Rondani di Parma con 
96/100, ma poi ho deciso di 
cambiare ambito e adesso mi sto 
laureando in Scienze della 
Comunicazione a Reggio Emilia.

Ho da sempre la passione per il 
disegno e ultimamente mi è nata 
anche quella per il teatro, che sta 
diventando un lavoro vero proprio. 
Infatti faccio parte di una 
compagnia che si chiama Rodisio, 
in cui mi sto formando come 
attore e come tecnico luci e 
suoni. 
 
Mi piace leggere, scrivere, 
guardare film, andare in 
montagna, sciare e mangiare. 
 
"Meglio cento bernoccoli che 
perdere la libertà" 

Ho lavorato un paio di estati in 
uno studio di grafica 
pubblicitaria, un paio di estati in 
fabbrica a fare gelati e una 
settimana nei campi a raccogliere 
le cipolle.
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3 Luglio 
IL VIAGGIO COMINCIA
Un viaggio necessita per 
definizione di un'andata e di un 
ritorno. Il mio viaggio inizia da 
Parma la mattina del 3 Luglio e mi 
porterà a vagare tra teatri, festival 
paesi, regioni, case, alberghi e 
persone per un mese circa. Il filo 
conduttore sarà sempre il teatro. 
 
La prima tappa è Volterra, piccolo 
paese in provincia di Pisa in cui 
ogni anno Carte Blanche e la 
Compagnia della Fortezza 
organizzano un importante festival 
teatrale. Il motivo per cui vado a Volterra? 

La compagnia con cui lavoro sta 
preparando un nuovo spettacolo 
che si chiamerà storie di una 
famiglia  e che debutterà nel 
festival 24 Luglio. Io sarò il 
tecnico e pertanto mi occuperò di 
luci e audio, però durante questi 
giorni seguirò tutto lo svolgimento 
del lavoro per iniziare a capire 
come nasce uno spettacolo.

A Volterra sarò l'ultimo arrivato 
perché gli altri elementi della 
compagnia (Davide, Manuela, 
Consuelo e Beatrice) sono già al 
lavoro dal 26 Giugno. Mi hanno 
detto che abbiamo una casa piccola 
ma stupenda!
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4 Luglio 
UNA NUOVA CASA
Una cosa stupenda del viaggiare è 
che ogni volta ci si trova ad 
abitare in una nuova casa. La 
nostra casa di Volterra è 
meravigliosa! E' così composta: un 
ingresso ricavato in un portico, 
con tante finestre, con un forno a 
legna e un tavolo lungo in cui 
mangiamo; un soggiorno-cucina 
con divano letto in cui dormiamo 
io e Davide; un piccolo bagno e 
una camera matrimoniale in cui 
dormono Consuelo e Beatrice e in 
cui c'è l'armadio comune con tutti i 
vestiti. 

Siamo appena sotto la città, in piena  
collina toscana, e di fronte a noi 
abbiamo un orto meraviglioso ed un 
panorama mozzafiato. L'unico segno 
di civiltà presente sono i vicini 
inglesi. 
 
La mattina del primo giorno mi alzo 
con un mal di schiena terribile 
(merito del divano-letto). Al 
pomeriggio comincia il lavoro: 
laboratorio con i bambini del 
centro estivo di Volterra e 
presentazione dell'anteprima dello 
spettacolo. I bambini riescono 
sempre a stupire e ad essere geniali. 
Il laboratorio consiste nel farli 
lavorare sul tema della famiglia per 
raccogliere materiale e spunti su cui 
lavorare nei prossimi giorni. 
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5 Luglio 
VISITE E DIFFICOLTA'
Una delle mie passioni quando 
sono lontano da casa è 
vagabondare alla ricerca di posti 
strani. Qui a Volterra sapevo che 
c'era un vecchio ospedale 
psichiatrico abbandonato e così 
ho deciso di fare una visita 
mattutina. 

Trovare il posto è stato semplice, 
entrare un po' meno. Ma alla fine 
una finestra che si apre la si trova 
sempre. L'interno è agghiacciante. 
Ci sono i vecchi arredamenti e le 
piccole celle in cui vivevano i 
"matti". 

Gli orari del lavoro sono flessibili e 
seguono le esigenze giornaliere e la 
disponibilità dello spazio per provare. 
Il festival ci ha infatti messo a 
disposizione un piccolo teatrino a 
fianco degli uffici di Carte Blanche. 
 
Dopo la mattina libera il pomeriggio 
si torna al lavoro con le prove vere e 
proprie. Io ho fatto riprese video e ho 
preso appunti di regia. 
 
Già da questi primi giorni mi rendo 
conto che vivere e lavorare sempre a 
stretto contatto non è facile. 
Soprattutto per me che ho spesso 
bisogno di staccare la spina dal resto 
del mondo. In più il lavoro è molto 
stressante perché il tema della 
famiglia non è facile da affrontare. 
 

L'atmosfera è surreale. Cercando 
in mezzo ai mucchi di oggetti si 
trovano anche documenti e 
diagnosi ospedaliere. 

Tra le visite della mattina anche 
una tomba etrusca buia e 
puzzolente trovata aprendo un 
cancello lungo la strada di casa! 
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Stamattina Bea è tornata a Parma 
perché domani si sposa non-ho 
capito-bene-chi. L'abbiamo 
accompagnata a Prato in stazione 
e intanto ne abbiamo approfittato 
per andare nei grandi magazzini 
tessili dell'area industriale alla 
ricerca di vestiti e stoffe per i 
costumi di scena. 
 
Il tragitto tra Prato e Volterra 
attraversa la campagna toscana 
passando per Pontedera. Il 
paesaggio è magnifico e non è 
difficile incontrare enormi distese 
di girasoli e vecchi uliveti. 
 

6 Luglio 
RICERCA COSTUMI

Siamo partiti con un'idea ben 
precisa sul magazzino in cui 
andare, ma lo abbiamo trovato 
spodestato dai cinesi, come gran 
parte dei vecchi magazzini storici. 
Così ci siamo trovati a vagare 
sotto il sole battente nell'enorme 
quartiere industriale senza trovare 
niente di niente... 

La giornata doveva essere 
rilassante e invece si è rivelata 
traumatica. Come se non 
bastasse al ritorno abbiamo 
trovato una coda infinita sulla 
FI-PI-LI e siamo arrivati a 
Volterra tardissimo.

(   )
PICCOLA PARENTESI STORICA
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Volterra è stata una delle 
principali città etrusche e 
sorge sopra una rupe 
calcarea. Il suo nome era 
anticamente Volaterra a 
causa dei frequenti 
terremoti che colpivano la 
città. Oggi è nota per i resti 
storici e per il carcere di 
massima sicurezza 
all'interno della fortezza.
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7 Luglio 
MASCHERE
La ricerca di vestiti e oggetti di 
scena continua. Questa volta al 
mercato di Pisa. Siamo solo io e 
Consuelo perché Davide è rimasto 
a casa a scrivere il copione (che 
viene fatto e disfatto praticamente 
ogni giorno). 

La ricerca non è stata molto 
fruttuosa, ma per fortuna  
abbiamo ricevuto l'invito a pranzo 
di Giulia e Ferdinando. Lei 
studia teatro-terapia a Milano con 
Consuelo e lui è una persona 
interessantissima!

Entrando quello che colpisce 
l'attenzione è l'enorme quantità di 
maschere che si trovano 
praticamente ovunque. 
Ferdinando infatti è un educatore 
che coltiva da sempre la passione 
per le maschere, di cui è abile 
costruttore e su cui ha scritto 
diversi saggi. Inoltre è un ex 
attore teatrale e burattinaio con la 
passione per il disegno e la 
fotografia. La casa è meravigliosa.

A tavola ci vengono serviti: risotto 
al nero di seppia; arrosto con 
patate; polpettone di verdure e 
yogurt greco con miele, pinoli e 
cannella. Niente male... 
Siamo partiti per cercare costumi e 
invece abbiamo trovato maschere, 
cibi e conversazioni interessanti.
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8 Luglio 
MARE E GJERGJI

Bea è ancora a Parma e quindi il 
lavoro non può continuare. Così 
mentre Davide continua a scrivere 
il copione io e Consuelo 
continuiamo a fare vacanza. 

Ci siamo svegliati a mezzogiorno, 
abbiamo pranzato in giardino e 
poi siamo andati al mare: Marina 
di Bibbona. E' stata la tipica 
giornata da villeggianti: sveglia 
tardi, spiaggia,  lettura, bagno, 
passeggiata. In fondo è risaputo 
che lavorare troppo fa male. 

Nel ritorno abbiamo incontrato 
uno di quei baracchini che fanno 
primi piatti e panini. Mi sono 
mangiato una favolosa focaccia 
con lardo, cipolla fresca e 
pecorino dolce. Un paradiso dei 
sensi! Adoro i panini, adoro il 
lardo, adoro la focaccia e adoro 
far merenda! Non poteva 
capitarmi niente di più gradito.

Prima di cena è arrivato Gjergji, 
un ragazzo albanese con cui sto 
partecipando a Premio Scenario, 
concorso biennale nazionale di 
teatro. Lo spettacolo che 
presentiamo si chiama Ilir. Sempre 
con questo spettacolo abbiamo 
vinto in Maggio il premio speciale 
della giuria nel concorso di Ustica.  

A cena è venuta anche Manuela. 
Fino ad ora non è stata molto con 
noi perchè, oltre ad essere regista 
della nostra compagnia, durante il 
Festival di Volterra lavora per Carte 
Blanche come aiuto alla regia di 
Armando Punzo.

Quando sono a casa cucino 
raramente ma adesso che sono 
via mi capita spesso di mettermi 
alla prova. Da quando sono 
partito ho già fatto: fiori di zucca 
fritti, olive all'ascolana, salsicce e 
pasta all'amatriciana. Però non ho 
ancora lavato i piatti.

riveere
sens !

ddoolce Un
a ee 

ar
at
ia

a

t



11

9 Luglio 
SANTARCANGELO

Sveglia presto e subito in teatro 
per le prove di Ilir. Questa volta 
però gli attori siamo io e Gjergji. 
Ilir significa libero, e lo spettacolo 
è una biografia della strana vita di 
Gjergji, da quando viveva in 
Albania a quando a quattordici 
anni è arrivato in Italia in treno.   

Finite le prove abbiamo mangiato 
un kebab e poi siamo subito 
partiti. La fase finale del concorso 
si terrà a Santarcangelo di 
Romagna e durante il tragitto 
dobbiamo passare a prendere 
Luca (che ci farà da tecnico) a 
Bologna. Va detto che Luca è il 
mio compagno di sventure 
preferito, quindi si prospettano 
momenti divertenti. 
 
Dovremo restare in Romagna per 
tre giorni perché la premiazione 
sarà il pomeriggio dell'undici. 
 
Il viaggio è devastante a causa del 
traffico e arriviamo alle nove 
passate.

Il nostro albergo è a Torre 
Pedrera, piccolo paese sul mare, 
così dopo una pizza da asporto 
mangiata seduti sul marciapiede 
siamo andati in spiaggia a riposarci 
un po'. Gjergji ha rubato un pedalò 
e per un po' non l'abbiamo visto. 

In stanza abbiamo un asciugamano 
in tre e dobbiamo restare tre 
giorni... Si spera di risolvere presto 
la situazione...
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10 Luglio 
LA FINALE
Dopo una notte con due ore di 
sonno (causa letti scomodi e 
caldo torrido) sveglia alle 7:40, 
colazione alle 8 e in subito in 
teatro. Il grande giorno è 
arrivato. Alle 11 dovremo 
presentare lo spettacolo davanti 
alla giuria del concorso. 
Insomma, è la finale.

La scenografia dello spettacolo è 
composta da una sedia e una 
cassetta di pomodori. Il teatro si 
chiama Il Lavatoio ed è piccolo 
e molto carino. La sala sarà piena. 

Dopo un lungo riscaldamento e 
un po' di tensione arriva il nostro 
momento. Tutto è pronto, le luci 
si spengono e nella sala si fa 
silenzio... 

E' stato un successo! Abbiamo 
ricevuto tanti applausi e 
complimenti. Domani ci saranno i 
verdetti. Lo spettacolo dopo il 
nostro faceva schifo. 

A pranzo una piadina e poi fino a 
sera in spiaggia e sul lungo mare.
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11 Luglio 
LA PREMIAZIONE

La mattina abbiamo sgomberato 
l'albergo e mentre Gjergji 
sputtanava soldi nelle sale giochi, 
io e Luca siamo andati a fare il 
tifo negli avvincenti tornei di 
bocce della riviera romagnola.  
 
Il pomeriggio c'è stata la 
premiazione e come avevo 
pronosticato abbiamo vinto! 
Siamo tra i quattro progetti 
segnalati della generazione 
scenario! Il malloppo consiste in 
1000 euro, che sommati ai 1000 
di premio Ustica fanno 2000 euro!

Subito dopo la premiazione 
abbiamo ricevuto grandi 
complimenti e tante offerte da 
teatri di tutta Italia, poi siamo 
subito partiti. Questa volta la 
destinazione è Parma. Prima 
però abbiamo lasciato Gjergji in 
stazione a Bologna. 
 
La convivenza con Gjergji non è 
stata facile. Sia io che Luca siamo 
arrivati a non sopportarlo più. E' 
viziato, logorroico, casinista e 
racconta un sacco di balle. Non so 
se il lavoro potrà continuare. 
 
Arrivato finalmente a casa ho 
avuto giusto il tempo di una 
doccia e poi sono corso a casa di 
Alice (la mia ragazza) per cena. 

PICCOLA PARENTESI TEATRALE

(   )
Premio Scenario è un concorso 
nazionale biennale. Vi partecipano 
circa 400 gruppi di cui 10 vanno 
alla finale di Santarcangelo e 4 
sono premiati. Gli spettacoli 
presentati sono corti di 20 minuti 
che devono superare tre tappe di 
selezione. I vincitori, denominati 
generazione scenario, dovranno 
poi sviluppare e rendere spettacoli 
veri e propri i loro lavori.
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12 Luglio 
UN PO' A CASA MIA
Finalmente una bella dormita nel 
mio letto, una bella doccia a casa 
mia e un po' di privacy. Da 
quando sono partito per Volterra 
non ho praticamente mai avuto 
un momento di tempo in cui stare 
da solo, in cui staccare da tutti, e 
cominciavo a sentirne il bisogno.

La mattina ho dormito fino a tardi 
e il pomeriggio sono andato con 
Alice al Parco Nevicati a dar da 
mangiare agli animali e a fare due 
passi nel verde.

Quello che più mi stressa del non 
essere a casa mia è non avere i 
miei tempi e i miei spazi. 
Mangiare, dormire, riposarsi, lavarsi 
e tutte le altre attività prendono dei 
ritmi diversi, a volte strani e 
intollerabili. 
Stare a casa invece rende tutti i 
problemi più piccoli e gestibili. 
 
Dopo cena Superquark. Domani 
mattina riparto per Volterra.

Le tensioni con Gjergji, gli spazi 
ristretti di Volterra e i continui 
viaggi mi hanno stancato e ora 
stare un po' a casa mia mi 
permette di respirare e 
riposarmi.
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13 Luglio 
DI NUOVO IN VIAGGIO

Appena un giorno di tregua e poi 
subito in viaggio. Mi alzo presto, 
faccio colazione e ritorno a 
Volterra. Sarei stato volentieri 
ancora a casa mia qualche giorno. 

Al mio arrivo ho trovato Bea, 
Davide e Consuelo già al lavoro 
e le prove sono proseguite fino 
alle 23:45 con un'unica 
interruzione per pranzare. Il 
giorno della spettacolo si avvicina 
e i ritmi si fanno più serrati. 

Mentre non c'ero il copione è stato 
smontato e rimontato, sono stati 
aggiunti nuovi pezzi e tolti pezzi 
che sembravano ormai consolidati. 
Questo, sommato ai tempi che 
cominciano a stringersi, ha portato 
qualche tensione. Cominciano ad 
esserci discussioni. Il lavoro si fa 
difficile e anche la convivenza. 
 
Penso che nei giorni a seguire 
passeremo gran parte della 
giornate in Teatro, e che da oggi 
tutti i ritmi della giornata si 
adegueranno ai ritmi di lavoro. In 
poche parole il duro del lavoro 
arriva adesso. 
Sapevo che più saremmo andati 
avanti e più sarebbe stata dura.

Un'altra novità è che è stata 
installata la mia postazione da 
tecnico. Finora il mio lavoro è stato 
più che altro quello di prendere 
appunti di regia e guardare e 
riguardare le prove. Ora posso 
invece cominciare a manovrare  luci 
e musiche. 
 
La colonna sonora è bellissima. Non 
vedo l'ora di vedere il lavoro finito. 
 
Oggi grande cucina: a pranzo 
tagliatelle con tartufo bianco e lardo 
di Colonnata e a cena ribollita 
toscana. Ovviamente tutti piatti non 
cucinati da noi ma dal ristorante.
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14 Luglio 
SOSPIRI

Sveglia alle 10, prove dalle 11 alle 
14:30, pranzo con tagliatelle, 
cozze e pomodoro fresco e poi io 
e Consuelo siamo partiti per Lari, 
piccolo borgo medioevale in cui 
andrà in scena Sospiri. 
 
Sospiri è uno spettacolo di  
teatro-danza creato dalla 
compagnia Il Corpo Creativo 
che mette in scena educatori, 
ragazzi della cooperativa sociale Il 
Giardino e volontari (tra cui me e 
Consuelo).

Arriviamo in paese alle 17:30, 
diamo una mano per il 
montaggio e facciamo qualche 
prova. Verso le otto ceniamo al 
sacco tutti insieme vicino al palco 
e poi cominciamo a prepararci. 
 
Lo spettacolo inizia alle 21:30 e 
finisce alle 24:20. Un successo.

Finito lo smontaggio siamo andati in 
albergo. Dormiremo a Tirrenia 
insieme al resto della compagnia e 
domani pomeriggio torneremo a 
Volterra. 

Tra un brindisi e l'altro fino alle tre 
di notte non siamo andati in 
camera. Negli ultimi cinque giorni ho 
dormito in quattro città diverse. 
Niente male.  
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15 Luglio 
AVANTI E INDIETRO
Questa volta mi è andata bene. 
La mia nuova casa (l'albergo di 
Tirrenia) è molto carina. 
Peccato che mi fermerò poco 
visto che entro sera dovrò 
tornare a Volterra. 

La mattina, dopo la sveglia alle 9, 
colazione con cappuccino, 
brioches, banana e cioccolato. 
Poi in spiaggia con i ragazzi. Il 
mare non è un granché, ma c'è 
un campo da beach volley e 
questo basta per divertirsi.

Dopo pranzo (lasagne e arrosto con 
patate) e dopo un motomondiale 
disastroso (Valentino è caduto) io e 
Consuelo siamo ripartiti per 
Volterra. 

Dalle 16:30 alle 21:30 abbiamo 
fatto prove su prove e sembra che 
lo spettacolo cominci a funzionare. 

A cena tagliere misto di formaggi 
e salumi toscani. Si cena sempre 
ad orari strani finendo le prove 
tardi. Poi finisce che si va a letto 
tardi e ci si alza tardi. 
 
Addio letto comodo di Tirrenia. Si 
torna al temibile divano-letto di 
Volterra...
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La compagnia è formata da oltre 
venti persone, ma tra questa ce 
n'è una in particolare che merita 
di essere presentata: Giordano. 
 
Giordano è un educatore della 
cooperativa in cui è nato il 
progetto Sospiri. Anzi, insieme a 
Consuelo (che è la sua ragazza) è 
l'ideatore del progetto. 
 
E' una persona molto tenace e 
creativa, di quelle che non si 
fermano mai. Oltre a questo 
spettacolo ne ha messo in piedi 
un altro che andrà in scena il 22 
Luglio al Festival dei Girovaghi 
e a cui parteciperò anche io.
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16 Luglio 
STRANI OGGETTI
La solita sveglia tardi e poi in 
teatro per provare fino alle 14:30. 
A pranzo un panino e poi dalle 
15:45 sono venuti di nuovo i 
bambini del centro estivo a cui 
abbiamo mostrato l'anteprima 
dello spettacolo. Questa sarà 
l'ultima prova aperta prima del 
debutto. Dalle 17 alle 19 abbiamo 
continuato le prove a porte 
chiuse. 

Finite le prove sono partito per 
tornare a casa. Domani infatti io 
Manuela e Davide saremo a 
Reggio Emilia con lo spettacolo Il 
lupo e la capra. 

Da quando sono a Volterra ho 
trovato un sacco di oggetti strani, 
tra cui una macchinina e un 
carrellino. 

Sono arrivato a casa alle 22:30 e 
sono proprio contento. Oggi è stata 
una giornata pesante. Comincio a 
non sopportare più qualcuno... 
Questa volta mi fermerò a Parma 
fino al 23 e la prospettiva non mi 
dispiace. 

Finalmente il piacere di dormire nel 
mio letto (con i suoi inquilini) e di 
mangiare e svegliarmi con i miei 
orari soliti.
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17 Luglio 
IL LUPO E LA CAPRA

Sveglia alle 9. Ho passato la 
mattina con Alice, che rimarrà 
con me fino a sera, e poi ho 
finalmente mangiato a casa. 

Dopo pranzo ho guardato un film 
e alle 17 sono andato a caricare 
la scenografia de Il lupo e la 
capra sulla macchina. 

Lo spettacolo verrà fatto nel 
cortile interno della biblioteca 
Panizzi di Reggio Emilia.

E' la storia di un lupo e di una 
capra, nemici nell'immaginario 
comune, che per caso s'incontrano, 
in una notte senza luna, non si 
riconoscono e si scoprono più vicini 
di quanto si possa credere. 

E' la storia di due che, 
inconsapevolmente, sfidano quella 
logica che dice che le cose sono 
sempre andate così e quindi non c'è 
motivo di cambiarle. 

E' la storia di due ribelli 
inconsapevoli e quindi di 
un'utopia. 

All'1:20 ero nel mio letto.Il lupo e la capra è uno spettacolo 
per bambini liberamente tratto dal 
libro In una notte di temporale 
di Yuichi Kimura. Ad Aprile ha 
vinto il premio Eolo come miglior 
Spettacolo Teatro Ragazzi 
Italiano. Davide e Manuela sono 
gli attori (rispettivamente lupo e 
capra) e io sono il tecnico. Nella 
stagione 2008 avremo oltre cento 
date in Italia ed Europa con 
questo spettacolo.
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18 Luglio 
CASA DOLCE CASA

Finalmente una settimana intera a 
casa. Il motivo è che il 22 sarò in 
scena al Festival dei Girovaghi 
di Compiano (PR) e quindi è 
inutile tornare a Volterra per poi 
tornare ancora a casa. E poi ne 
avevo proprio voglia.

Ho passato quasi tutta la giornata 
a casa di Alice. A pranzo ho 
mangiato gnocchi con aglio, 
basilico e pomodori freschi e dopo 
mangiato ho giocato a carte fino 
alle 16. 
 
A Parma c'è un caldo torrido e non 
si sa dove stare. Sembra di 
nuotare nel brodo. Il clima di 
Volterra era decisamente migliore.

Prima di cena ho smontato la 
scenografia di lupo e capra e ho 
letto un po'. Dopo mangiato sono 
andato ai giardini San Paolo per 
la tradizionale Notte Horror, 
rassegna cinematografica di film 
dell'orrore. 

La testa comincia svuotarsi e i nervi 
a distendersi. Effetto casa.
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19 Luglio 
IN CERCA DI FOSSILI

Sveglia alle 8 e colazione. 
Guardando fuori dalla finestra il 
tempo non sembra promettere 
niente di buono, ma chiamo 
comunque il mio socio di sventure 
Luca per decidere cosa fare. 

L'idea è di andare in cerca di 
fossili sul Monte Caio, poco 
lontano dalla sua casa di 
montagna di Tizzano (PR). 

Dopo pranzo partiamo.

Sul posto troviamo una parete di 
roccia enorme su cui proviamo ad 
arrampicarci con scarsi e 
pericolosi risultati. Cercando tra i 
sassi troviamo alcuni fossili di 
fucoidi: tracce fossili di 
microorganismi marini. Almeno 
non siamo venuti per niente.

Al ritorno ci siamo fermati a casa di 
Luca per innaffiare e dare da 
mangiare alle galline. 

La casa è stupenda, tutta in sasso e 
legno, grande quanto basta e con 
un bel pezzo di terra intorno che 
arriva fino al fiume. 

Finiti i lavori agricoli è scattata 
una gara a chi riusciva a colpire il 
palo della luce più lontano tirando le 
pere e le mele cadute dall'albero. 
Ovviamente nessuno dei due è 
riuscito a prenderlo, quindi è finita 
con un onesto pareggio. 

Far rientrare le galline nel pollaio 
non è stato semplice affatto...aa

e

g
qq

o
tet
oo
ivciv
o

.
ra
n
a

ffce ffc
ne



22

20 Luglio 
AL FIUME

Sveglia alle 9, la solita colazione e 
la solita telefonata a Luca per 
decidere cosa fare. Alla fine la 
scelta è di andare in fiume a 
prendere un po' di sole.

Abbiamo deciso di andare nell'alta 
Val Ceno. Abbiamo trovato un 
posto fantastico senza troppa 
gente e con l'acqua fredda al 
punto giusto. 

Ovviamente non siamo riusciti a 
stare fermi per più di mezzora e 
sono scattate gare di rimbalzi 
sull'acqua lanciando sassi.

Ieri Alice è partita per la Puglia e 
tornerà tra una settimana. 

A pranzo nodini di vitello all'aceto 
balsamico e una fetta enorme di 
cocomera. Finito di mangiare 
siamo partiti subito. Fa 
caldissimo e bisogna scappare 
dalla città.

Nel tornare a casa ci siamo fermati 
in un piccolo alimentari per fare 
merenda. Dopo una giornata di 
duro lavoro un panino con la 
pancetta e il pecorino ci 
sembrava doveroso. 
 
La sera sono rimasto a casa a 
leggere. Domani sveglia presto.
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21 Luglio 
LE CASCATE
Sveglia ore 7. Poco dopo la 
partenza alla volta del Parco del 
Gigante, nell'Appennino Tosco-
Emiliano. La meta sono le 
Cascate del Lavacchiello. La 
compagnia è formata da me, la 
mia mamma e mio zio Guido. 

Prima di partire ci siamo fermati a 
riempire le borracce alle sorgenti 
di Ligonchio e poi abbiamo iniziato 
la camminata. 
 
Il sentiero è stupendo e la prima 
parte attraversa una faggeta 
enorme e molto vecchia. Ci sono 
alberi grandissimi.

In tutto sono circa tre ore di 
cammino, quindi un sentiero della 
domenica alla portata di tutti. Però 
il panorama dall'alto merita. 
 
Finalmente vediamo le cascate. 
Non c'è molta acqua ma è 
sufficiente per rinfrescarsi un po'.  
 
La sera a cena dalla nonna: tortelli 
di zucca, arrosto e cocomera.
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22 Luglio 
FESTIVAL DEI GIROVAGHI

Sveglia ore 9. Colazione e carico 
della scenografia sulla macchina. 
Ore 10 partenza per Compiano 
perché oggi pomeriggio saremo in 
scena al Festival dei Girovaghi. 

Compiano è un piccolo borgo 
medioevale con tanto di castello in 
provincia di Parma. Il festival 
raccoglie artisti di strada e non, 
provenienti da varie parti d'Italia. 

Il mio gruppo è formato da dodici 
persone e per la partecipazione 
dobbiamo ringraziare Giordano 
(vedi Sospiri).

La nostra idea è quella di 
articolare un percorso 
sensoriale in cui ognuno avrà 
una propria postazione autonoma 
in vari angoli del paese. La mia 
postazione è vicino ad una 
rampa di scale e la scenografia è 
formata da pali di acciaio. 

E' stato un flop totale. C'era 
molto caldo e non è venuto 
nessuno...
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23 Luglio 
RITORNO A VOLTERRA

Ormai ho imparato a memoria la 
strada che da Parma arriva a 
Volterra... 

Sono partito alle 11 e arrivato alle 
14. Alle 15:30 abbiamo pranzato 
(tagliere con bruschette olio e 
pomodoro, lardo, prosciutto 
toscano olive e formaggio). 

Dalle 16 alle 19:30 abbiamo fatto 
le prove, che ormai sono 
definitive  e anche le ultime 
perchè domani ci sarà il debutto!

Mentre non c'ero lo spettacolo si 
è modificato ancora. Ora è 
davvero pronto ed è bellissimo! 
Le tensioni passate dovute alla 
difficoltà del lavoro sono spente. 
Ora ci sono nuove tensioni 
(strizza) legate al debutto 
davanti al pubblico. 

Il teatro è stato preparato e sono 
state aggiunte le gradinate. Le 
luci sono state puntate e anche la 
mia postazione da tecnico è 
stata completata: mi hanno 
sostituito il vecchio mixer luci con 
uno nuovo e al posto del lettore 
cd ho un nuovo mixer audio. 

Dopo le prove abbiamo preso un 
aperitivo con altre persone del 
festival. Volterra adesso è uno 
spettacolo continuo ed è piena di 
artisti perché è iniziato il 
Festival. 

Abbiamo cenato a mezzanotte e 
mezza con un risotto ai funghi.tot
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24 Luglio 
IL DEBUTTO

E' il grande giorno. Finalmente va 
in scena Storie di una famiglia! 

Sveglia ore 9 e dopo la colazione 
subito in teatro. Abbiamo finito di 
sistemare la scenografia e fatto 
una prova tecnica. Come al solito 
arrivo allo spettacolo senza avere 
mai fatto una prova completa! 

Faremo una doppia, cioè due 
spettacoli nello stesso giorno. Uno 
alle 17:30 e uno alle 20:30.

A pranzo un panino e una birra. 
Nel frattempo sono arrivate Sara e 
Agnese (altre due persone che 
lavorano con la compagnia) che si 
fermeranno fino al 28 per seguire 
il laboratorio tenuto da Davide qui 
a Volterra. 
 
Il primo spettacolo è andato bene, 
anche se era un po' scarico. Per la 
replica di stasera verranno a 
trovarmi alcuni dei miei amici 
toscani che non vedo da tempo: 
Irene, Eva, Marco e Flavia da 
Firenze; Alice da Massa e Giulia da 
Siena. Sono contento di rivederli e 
di riunirli tutti qui a Volterra.

Il secondo spettacolo è andato 
benissimo! E' stato un grande 
successo e devo dire che è 
piaciuto parecchio anche a me. 

Lo spettacolo racconta di una 
famiglia normale, con una vita 
normale e problemi normali, ma 
che un giorno si trova ad essere in 
crisi e non capisce il perché. 

Dopo cena ho salutato i miei amici 
e sono andato al Dopofestival, 
cioè una grande festa che si tiene 
ogni sera durante le settimane del 
festival. 

Ah dimenticavo! In regia con me 
c'era Tina, la nostra mascotte!aa
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Eccoli all'opera: padre (Davide), 
madre (Consuelo), figlia (Bea). 
Meritavano decisamente di essere 
visti. La scenografia era 
scarsissima: un lampadario, tre 
sedie e un tavolo. Ma gli attori 
hanno saputo creare un mondo.
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25 Luglio 
MOLLO TUTTO

Mi sono svegliato alle 10:20 
mentre gli altri dormivano ancora 
e sono andato a fare due passi. 
Adesso che sono arrivate Sara e 
Agnese siamo in sei in casa. E 
già in quattro non si stava larghi. 
C'è qualcosa che non va. 

Gli altri si sono svegliati alle 
12:30. Abbiamo fatto colazione 
all'una e quindi non pranzeremo. 
Ho una gran voglia di tornare a 
casa mia...

Nel primo pomeriggio ho 
accompagnato Davide a Carte 
Blanche e gli ho parlato. Sono 
saturo. Per di più in casa c'è una 
persona che non sopporto più. Ho 
bisogno di staccare. 
 
In realtà sarei dovuto rimanere 
fino al 28 perché oggi cominciava 
un seminario e nei programmi 
c'era che io lo seguissi insieme al 
resto della compagnia. 
 
Alle 15:30 sono partito. Oltre al 
seminario mi perderò lo spettacolo 
della Fortezza e tutti gli altri eventi 
del festival.

Quando sono partito non stavo 
molto bene per motivi personali. 
Questo, sommato ai ritmi 
strampalati e a tensioni nate 
vivendo a stretto contatto mi ha 
portato a scoppiare e ad avere 
bisogno di aria. 

Sento il bisogno di avere i miei 
spazi, i miei ritmi, di essere in 
mezzo alle mie cose. Non mi era 
mai capitato di avere così bisogno 
di essere a casa mia. Sono 
sempre stato un buon vagabondo. 

Alle 18:30 arrivo a casa. E respiro.n vo
noo
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26 Luglio 
LA TESTA SI SVUOTA

Che bello essere a casa! Ne avevo 
proprio bisogno. Mi sono svegliato 
alle 9:30, ho fatto colazione e mi 
sono letto tutto il vecchio e il 
mare. Ho una gran voglia di 
leggere e non pensare a niente.

Stasera Alice torna dalla Calabria 
e prima di dormire preparo panini 
e zaini perché domani andremo a 
fare un giro in montagna. 
 
Mi rendo conto che stare in giro 
per passione o per piacere è una 
cosa, girare per lavoro e vivere 
con le persone con cui si lavora è 
un altro. 

Il pomeriggio sono andato in 
piscina con Luca. L'attività 
prevalente è stata l'ozio al sole, 
interrotta solo da qualche bagno. 
Incomincio già a sentire la testa 
che si fa meno pesante. Mi 
sembra di non essere mai partito.

Anche la cucina ha la sua 
importanza. Per quanto abbia 
mangiato cose buonissime e abbia 
assaggiato tutti i piatti tipici che 
incontravo, dopo un po' sentivo 
proprio il bisogno della cucina di 
casa. 

E a cena finalmente, dopo gli 
spaghetti al pomodoro del pranzo, 
arrivano la cotolette della 
mamma! 

Dopo mangiato ho fatto un po' di 
collage usando vecchi giornali. 
Non mi sono ancora riabituato 
all'idea di dormire da solo nel mio 
letto, e mi sembra un lusso! 
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27 Luglio 
LE CASCATE (REMAKE)

Alla fine la scelta è stata di 
tornare alle cascate del 
Lavacchiello perché anche Alice 
le voleva vedere. Così dopo una 
sveglia presto ma non troppo 
siamo partiti. 
 
Il tempo è molto strano e 
momenti di sereno si alternano a 
grossi nuvoloni neri. Se 
piovesse proprio oggi sarebbe il 
colmo visto che non piove da 
mesi. 

Durante il sentiero ci siamo 
imbattuti in una selva di 
lamponi, tutti maturi e piuttosto 
grossi. Ovviamente non 
potevamo resistere alla 
tentazione e ci siamo messi a 
raccoglierli. 
 
Intanto il cielo si fa sempre più 
nero e cominciano i primi tuoni.

Abbiamo fatto appena in tempo 
ad arrivare in cima e mangiare, 
poi siamo dovuti scendere causa 
temporale imminente. 

Comunque la giornata è stata 
redditizia, e domani con i lamponi 
raccolti tenteremo una crostata.
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28 Luglio 
LA CROSTATA

Sveglia ore 9 e colazione. Il resto 
della mattina è passato facendo 
qualche lavoro in casa e leggendo 
il giornale. 

Il pomeriggio è venuta Alice e ci 
siamo messi subito all'opera. La 
missione è riuscire a trasformare 
uova, farina e lamponi in una 
crostata. 

Ovviamente non è filato tutto 
liscio, ma alla fine ce l'abbiamo 
fatta! 

Ovviamente, essendo una nostra 
creazione dovevamo anche 
assaggiarla. E così dopo poco la 
crostata era quasi sparita... 

Con oggi penso che i viaggi 
dell'estate siano finiti e che da 
domani ricominci la vita di tutti i 
giorni. Nello spettacolo Ilir 
concludevo dicendo che tutto 
serve a qualche cosa. Con il 
tempo, forse, capirò anche a cosa 
è servita questa estate di viaggi.
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LE TAPPE
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LA MIA TESI

L'IDEA: 
Come spesso succede le cose si 
legano l'una all'altra e le strade 
prendono forma. Così, senza 
averci mai pensato prima, mi 
sono trovato a fare una tesi che 
parla del viaggio. 

Lo spunto è nato mettendo 
insieme l'argomento del corso di 
editoria multimediale 2007/08 
e i miei impegni per l'estate. 

L'unica cosa che sapevo è che 
avrebbe preso la forma di un 
piccolo e-book.

LA REALIZZAZIONE: 
Quaderno alla mano ho tenuto un 
piccolo diario durante tutta la 
durata dei miei spostamenti, in cui 
annotavo le cose più belle, le cose 
più strane e quelle più importanti. 
Nel frattempo cercavo di 
documentare tutto facendo 
fotografie. 

A mano a mano che il materiale 
aumentava iniziavo a vedere quali 
sarebbero state la struttura e la 
logica che mi avrebbero 
permesso di dare un ordire alle 
pagine e nel frattempo di renderle 
piacevoli e interessanti. Per il 
lavoro d'impaginazione sapevo 
che avrei utilizzato Adobe 
Acrobat 8 Professional. 

A questo punto, una volta tornato 
a casa, mi sono costruito una 
griglia di layout da cui partire per 
ogni singola pagina. Poi, fantasia 
e tastiera alla mano, ho iniziato a 
scrivere e quello che avete 
davanti agli occhi è il risultato del 
lavoro svolto.
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LA MIA UNIVERSITA'
ALLA FINE DEL VIAGGIO ANALISI DEI PRO E DEI CONTRO

Quando è stato il momento di 
iscriversi all'università ero indeciso 
tra tredici facoltà. Non avendo le 
idee chiare ho cercato di prendere 
la strada che rimaneva più aperta, 
quella che mi avrebbe vincolato il 
meno possibile ad un punto di 
vista univoco sulle cose. 
 
Scienze della Comunicazione, 
con la sua offerta che spaziava 
dalla psicologia all'informatica, 
dalla sociologia alla semiotica e 
dalle lingue all'editoria, mi è 
sembrata in assoluto la facoltà 
con la più ampia visuale. 
 
Adesso che ho finito la prima 
parte del viaggio mi rendo conto 
che per me è stata la scelta 
giusta, ma che l'università da sola 
non sarebbe bastata. 

Quello di cui però ho sempre 
sentito la mancanza era la 
possibilità di fare concretamente, 
di produrre, di mettermi alla prova 
realmente, di acquisire un sapere 
concreto, un saper fare. E questo 
sembra impossibile all'interno 
dell'università, luogo in cui la 
massima creazione consentita è la 
produzione di una tesina. 
  
"Se ascolto so, se vedo 
capisco, se faccio imparo."  
- Bruno Munari - 
 
Più volte durante gli anni di studio 
ho avuto la sensazione che 
l'università fosse un ovile, in cui le 
pecore-studenti vengono nutrite 
con omogeneizzato cerebrale.

Durante tutta la durata del 
percorso universitario mi sono 
"costruito" una formazione 
parallela, fatta di attività 
concrete e reali che, pur 
rimanendo nell'ambito della 
comunicazione, ne seguivano 
rami specifici. 
 
Questa formazione parallela è 
dovuta più alla mia curiosità 
personale che non ad una reale 
intenzione di rinforzare il percorso 
di studi. Oggi, però, mi accorgo 
dell'importanza che per me ha 
avuto; infatti mi ha permesso di 
trovare un lavoro (il teatro) prima 
di laurearmi, cosa che 
semplicemente studiando non 
sarebbe certo successa. 
 
La base teorica che l'università 
mi ha fornito ha senz'altro 
allargato i miei orizzonti. 
 continua...
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Se da una parte questo stimola lo 
studente ad impare a far da sé, 
viene però da domandarsi perché 
ci siano tante persone pagate se 
poi uno si deve arrangiare come 
può. 

Per concludere, a chi vuole 
iscriversi a Scienze della 
Comunicazione (e a chi già è 
iscritto) consiglio di affrontare il 
percorso con voglia di fare ma 
senza accontentarsi di quello che 
viene proposto in aula. Di cercare 
altre vie, di sperimentare e di 
trovare il modo di sviluppare le 
loro potenzialità e quello che 
sanno fare meglio. 

Il percorso universitario è solo 
una base, l'inizio di un viaggio, 
che però da solo non basta.

Spero un giorno di vedere 
l'università come luogo in cui la 
ridicola contrapposizione tra 
studenti e insegnanti viene 
superata, a favore di un nuovo 
rapporto di collaborazione e voglia 
di fare insieme. 
 
Ciò per cui sarò sempre grato alla 
mia facoltà è avermi fatto 
sviluppare un senso critico 
rispetto alle cose, un senso critico 
nel modo di pensare e di cercare. 
L'avermi insegnato che esistono 
altre strade da percorrere. 
 
Per quel che riguarda la facoltà 
fisicamente intesa, penso che la 
Caserma Zucchi sia quanto di 
più bello si possa desiderare. 
 
Un po' meno felice è la 
burocrazia. La segreteria 
studenti e la segreteria di facoltà 
sono i luoghi per eccellenza in cui 
il tempo viene perso inutilmente 
senza vedere risolti i propri 
problemi e magari senza essere 
trattati con educazione.  
 

Quello che vorrei è un'università in 
cui agli studenti viene fornita la 
possibilità di crearsi un percorso 
unico e individuale, in cui 
ognuno possa distinguersi per 
quello che sa fare, in cui ogni 
esame non ha due libri fissi da 
studiare, ma offre la possibilità di 
una scelta tra tanti libri e tanti 
punti vista. 
 

Mi sono sempre chiesto com'è 
possibile che a trecento persone 
(e quindi a trecento teste e modi 
di pensare differenti) vengano 
proposti gli stessi due o tre libri. 
Questo non è il modo di stimolare, 
ma di castrare le unicità e le 
differenze che fanno di ogni 
soggetto qualcosa di unico. 

Per una facoltà che propone come 
suoi i valori di avanguardia, 
unicità, affidabilità e  
desiderabilità, penso che questo 
modo di lavorare sia quantomeno 
un controsenso.

...continua
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Cercherò in questa sezione di 
spiegare quali sono stati i 
principali passaggi e problemi che 
ho dovuto affrontare durante la 
produzione dell'e-book. 

Il primo problema è legato alla 
raccolta del materiale, che nel 
mio caso è avvenuta a monte del 
processo di scrittura e in posti 
lontani e nei quali non sarei 
potuto tornare durante 
l'elaborazione. In questi casi è 
assolutamente indispensabile fare 
il maggior numero di foto 
possibile e farle al meglio. 
Altrimenti ci si trova poi con 
materiale scarso o di bassa 
qualità. 

A questo punto iniziano i problemi 
legati all'uso del programma e alla 
forma da dare al testo. 

Adobe Acrobat 8 Professional 
è disponibile nella versione prova 
con durata di 30 giorni ed è 
interamente in inglese. Per chi 
all'inizio non riesce ad orientarsi 
con la lingua consiglio l'uso di 
Babilon, dizionario elettronico 
che permette di copiare le parole 
dal testo e incollarle nella finestra 
di ricerca senza dover perdere 
tempo a sfogliare dizionari di 
carta. 
 
La caratteristica fondamentale di 
Adobe Acrobat 8 Professional, che 
lo differenzia dalle versioni 
passate, è che consente di creare 
un nuovo documento da un 
foglio bianco (File>Create 
PDF>From blank page) su cui è 
possibile scrivere e incollare 
oggetti. 
 
La prima scelta da effettuare è tra 
una pagina orizzontale oppure 
verticale.

RAPPORTO DI LAVORO
PASSAGGI E PROBLEMI A questo punto si tratta di trovare 

un modo semplice e veloce per 
lavorare con foto e testo 
affiancati. Per fare questo sono 
necessari alcuni passaggi: si 
riuniscono le foto in una cartella 
cercando di disporle con un ordine 
che sia consono al lavoro da 
svolgere; con Acrobat si crea un 
file PDF (File>Combine file) che 
contenga le foto; per ridurre le 
dimensioni delle foto e per avere 
meno pagine su cui lavorare si 
stampa il file ottenuto in un nuovo 
file, mettendo 4 o 6 foto per 
pagina (File>Print e poi in Page 
scaling>Multiple pages per sheet). 
 
L'operazione di stampa deve 
avvenire selezionando Adobe PDF 
come stampante predefinita. 
Alcuni problemi possono inoltre 
derivare dalla scelta 
dell'orientamento del foglio su 
cui stampare 
(File>Print>Properties>Layout> 
>Orientamento). 

continua...
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In questo modo è possibile 
lavorare tenendo aperto a 
sinistra il file di testo e a 
destra quello di foto 
(Window>Tile>Vertically), in 
modo che con un semplice copia 
e incolla le foto siano inseribili nel 
testo. 

La pagina bianca viene 
preimpostata con una griglia di 
testo, i cui margini sono 
modificabili. La mia scelta è stata 
però quella di lavorare con un 
testo su tre colonne, e per 
farlo ho usato i Text Box 
(Comments>Comment & markup 
toos>Text box tool). 

Giunti fin qui è necessario 
decidere e impostare la struttura 
grafica del testo e la sua 
organizzazione, cioè il layout. 
Come già detto ho deciso di 
lavorare su tre colonne affiancate 
di testo. 

Il problema che mi si poneva era 
quello di avere tre colonne con la 
stessa larghezza. Per farlo ho 
sfruttato la possibilità di 
modificare i margini dell'area di 
testo preimpostata. Così facendo 
potevo ottenere misure precise 
che partivano dai bordi del foglio. 
Una volta ottenute le misure che 
volevo le ricalcavo semplicemente 
con una linea rossa 
(Comments>Comment & markup 
toos>Line tool). Così facendo ho 
costruito una griglia di partenza 
che ho salvato e da cui sono 
partito per costruire ogni pagina. 
Altra modalità è usare la 
funzione Grid (View>Grid). 
 
La mia scelta è stata quindi di 
partire da una griglia di layout 
fissa che è rimasta costante in 
tutte le pagine. L'elemento su cui 
ho poi giocato sono state le foto, 
che ogni volta sono state disposte 
in modo diverso nello spazio per 
far si che non ci fossero quasi mai 
due pagine uguali. Quindi layout 
fisso ma variabile.

E' poi necessario scegliere in che 
ordine logico presentare le 
pagine, e per quel che riguarda il 
viaggio io ho scelto un 
normalissimo ordine cronologico. 

A lavoro terminato, quando tutte 
le pagine sono pronte, è 
consigliabile stampare 
interamente il documento su 
se stesso (sempre strumento 
Print ma ovviamente una sola 
pagina per foglio) per ridurre le 
dimensioni del file. Durante il 
passaggio da un file all'altro infatti 
le foto aumentano un po' il loro 
peso (vatte alla pesca...). Se si 
vuole inserire nel lavoro anche  
alcuni video è necessario farlo 
dopo questa operazione di 
stampa, altrimenti andranno persi 
diventando semplici foto. 

Ultima cosa: nel denominare le 
foto prima di stamparle sul 
nuovo file multiplo, è necessario 
ordinarle con numeri a tre cifre 
(es 001, 002, ecc) perché il 
programma conta nel seguente 
modo: 1, 10, 11, 12, ... 19, 2, 20, 
21, 22, ...

...continua
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FINE
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